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Preface 
 

 

Obtaining Technical Support 
To help us handle your technical support questions as quickly as possible, please have the following 
information ready before you call, or include it in a detailed technical support e-mail. 

You may send us your questions via e-mail, fax, or call one of our technical support specialists. Please allow 
up to two business days for a response.  

Hardware 

• A complete description of the problem; when does the problem occur; what are the environmental 
conditions; etc. 

• Product name and type 
• Product serial number 
• If it concerns a Diver: provide a DAT-file (and/or MON-file) if applicable 

Software 

• A complete description of the problem including a summary of key strokes and program event (or a 
screen capture showing the error message, where applicable)  

• Product name and version number 
• PocketPC make and model number 
• Operating system and version number 
• Software installation directory 
• Directory location for your current project files 



 3

Table of Contents 
1 Introduction.............................................................................................................. 5 

1.1 General............................................................................................................................................ 5 
1.2 Diver-Pocket Reader and Manager ............................................................................................. 5 
1.3 List of Supported Devices ............................................................................................................. 5 

Reading Units ....................................................................................................................................................... 5 
Divers.................................................................................................................................................................... 5 
Interface Cables .................................................................................................................................................... 6 
Wireless Devices .................................................................................................................................................. 6 

1.4 Software and Hardware Requirements ....................................................................................... 6 

2 Installing Diver-Pocket............................................................................................ 8 

2.1 Installation of Diver-Pocket with USB/RS232 Reading Unit..................................................... 8 
2.2 Upgrade Diver-Pocket to 2009.1................................................................................................. 10 
2.3 Quick Installation Guide............................................................................................................. 10 

3 Getting Started with Diver-Pocket....................................................................... 12 

3.1 Launching Diver-Pocket ............................................................................................................. 12 
3.2 Diver-Pocket Tabs ....................................................................................................................... 12 
3.3 Creating a Project........................................................................................................................ 13 
3.4 Reading Diver Data ..................................................................................................................... 13 
3.5 Plotting Data................................................................................................................................. 14 
3.6 Hiding & Exiting Diver-Pocket .................................................................................................. 15 

4 The Basics ............................................................................................................... 16 

4.1 Managing Projects ....................................................................................................................... 16 
4.1.1 Editing and Opening an Existing Project................................................................................................17 
4.1.2 Creating a New Project ...........................................................................................................................18 
4.1.3 Deleting an Existing Project ...................................................................................................................18 

4.2 Connecting to Diver-NETZ......................................................................................................... 18 
4.2.1 Setting up a Wireless Connection ...........................................................................................................19 
4.2.2 Downloading Data from Multiple Divers ...............................................................................................21 
4.2.3 Changing Wireless Diver Password........................................................................................................22 

5 Reading and Programming the Diver.................................................................. 23 

5.1 Reading Data and Settings from the Diver................................................................................ 23 
5.2 Viewing QA/QC Log.................................................................................................................... 24 
5.3 Reading Actual Data from the Diver ......................................................................................... 24 
5.4 Programming the Diver .............................................................................................................. 25 

5.4.1 Location ..................................................................................................................................................25 
5.4.2 Sample Method and Sample Rate ...........................................................................................................25 

Fixed ................................................................................................................................................................... 26 
Event Based ........................................................................................................................................................ 26 
Averaging Sampling Method.............................................................................................................................. 27 
Predefined Pumping Tests .................................................................................................................................. 27 
User Defined Pumping Test (Cera-Diver and Micro-Diver only) ...................................................................... 29 

5.4.3 Altitude ...................................................................................................................................................30 
5.5 Stopping a Diver .......................................................................................................................... 30 
5.6 Starting a Diver............................................................................................................................ 30 



 4 

5.6.1 Smart Future Start ...................................................................................................................................31 
5.7 Managing Diver Data .................................................................................................................. 31 
5.8 Exporting Data to a PC ............................................................................................................... 32 
5.9 Time Series Plots.......................................................................................................................... 32 
5.10 Plot Settings.................................................................................................................................. 33 

6 CTD-Diver Calibration ......................................................................................... 34 

6.1 Calibration.................................................................................................................................... 34 
6.2 Calibration History...................................................................................................................... 35 

7 Application Settings............................................................................................... 36 

7.1 Changing the Units ...................................................................................................................... 36 
7.2 Changing the Units (Detail) ........................................................................................................ 36 
7.3 Changing the Language .............................................................................................................. 37 
7.4 Compressing the Database.......................................................................................................... 37 

8 Troubleshooting ..................................................................................................... 38 

8.1 Interruption in Communication................................................................................................. 38 
8.2 Pocket-PC Power Management Issues....................................................................................... 38 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 5

1 Introduction 

1.1 General 
Diver-Pocket is a software package that can be used on a PocketPC for programming Divers, 
reading stored measurements and exporting data.   When used with a PocketPC, Diver-Pocket 
allows you to conveniently read and manage data in the field before exporting the data for 
further processing by other programs such as Diver-Office.  In combination with one or more 
Divers, Diver-Pocket constitutes a complete and flexible measurement system.  

1.2 Diver-Pocket Reader and Manager 
Diver-Pocket is available in two variants, namely; 

• Diver-Pocket Reader:  This variant only allows you to read data; Divers cannot be 
stopped, calibrated or programmed. 

• Diver-Pocket Manager: In addition to being able to read data, this variant also 
includes the Diver programming facility which allows you to calibrate CTD-Divers, 
start and stop Divers, define pumping test, etc. 

Note: This manual can be used for both the Diver-Pocket Reader and Diver-Pocket Manager.  
Please note that some features and functionality described in this manual are ONLY available 
in the Manager variant, i.e., programming Divers, calibrating divers, stopping Divers etc.  

Either the Reader or the Manager version can be installed on a Pocket-PC. There are two 
installation packages: 

• DiverPocket_Reader.exe 

• DiverPocket_Manager.exe 

A detailed description of the installation can be found in 
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Installing Diver-Pocket (page 3). 

1.3 List of Supported Devices 

Reading Units 
Diver-Office supports the following Reading Units: 

Reading Unit RS232 AS 315 

Reading Unit USB AS 324 

Diver USB Reading Unit AS 330 

Divers  
Diver-Office supports the following Diver groundwater dataloggers: 

Cera-Diver DI701 DI702 DI705 DI710 

Mini-Diver DI501 DI502 DI505 DI510 

Micro-Diver DI601 DI602 DI605 DI610 

(M)TD-Diver DI240 DI241 DI242 DI243 DI245  

Baro-Diver DI250 (TD-Style) DI500 (Mini-Style) 

CTD-Diver (ceramic) DI261 DI263 DI265 

CTD-Diver (stainless steel) DI218 DI219 DI221 DI222 DI223 DI224 DI227 
DI225 DI226 

TD-Diver 

D-Diver 

DI214 DI215 DI217 DI220 

DI212 DI213 

Interface Cables 
Diver-Office supports the following Diver interface cables:  

Direct Read Interface Cable AS 325 

PC Interface Boostercable  AS 326 

DRC USB Interface Cable AS 327 

Direct Read Interface (short) AS 328 

FT-US232B EVALCABLE HAD 211 
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Wireless Devices 
Diver-Pocket supports the following wireless devices: 

Diver-DXD CF Card AS333 

Diver-DXT AS4001 AS4002.5 AS4005 
AS4010 AS4020 AS4040 AS4080    
AS4160 AS4320   

1.4 Software and Hardware Requirements 
Diver-Pocket requires the following hardware and software requirements: 

PC Hardware Requirements: 

• Microsoft Windows 2000,  XP or Vista 

• Microsoft ActiveSync 3.6 or later must be installed (comes with PocketPC) 

PocketPC (PDA) Requirements: 

• Windows Mobile 2003,Windows Mobile Version 5.0 and Windows Mobile 
Version 6.0. 

• XScale or StrongArm Processor 

• Pocket-PC is compatible with USB Host CF Card or RS232 CF Card  

• 64 MB of RAM or more 

Wireless Requirements: 

• Diver-DXD wireless data transceiver dongle 

• Diver-DXT data transceiver 

Please refer to your owner’s manual to ensure that these requirements are satisfied. 

CF card: 

• http://www.ratocsystems.com/english/products/subpages/cfu1u.html 

• http://www.ratocsystems.com/english/products/CFU2U.html  

Diver-Pocket has been tested on the following Pocket-PCs: 

• Archer Field-PC (Jupiter Systems) 590MHz Windows Mobile 5 

with a USB and RS232 reading unit (and both CF cards). 
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2 Installing Diver-Pocket 

2.1 Installation of Diver-Pocket with USB/RS232 Reading Unit 
As outlined in the hardware requirements, Diver-Pocket requires a USB Host CF card or a 
RS232 CF card in order to read data from the Diver. This card must be properly installed 
according to the manufacturer’s instructions. The driver for the USB Host/RS232 CF card is 
delivered with the hardware, but is not included in the Diver-Pocket installation. The latest 
version of the USB Host/RS232 CF driver can be downloaded from the manufacturer’s site: 
http://www.ratocsystems.com/ 

To install Diver-Pocket on your Pocket-PC, follow the steps below:  

1. Before you start the installation of Diver-Pocket, make sure that the driver for the USB 
Host card is installed on your Pocket-PC. 

For additional guidance with this step, please visit our online installation guide at the 
following address: 

http://www.swstechnology.com/equipment_product.php?tab=3&ID=5 

2. Make sure that the USB Host card is not plugged into your Pocket-PC.  Please remove the 
card if it is plugged into your Pocket-PC. 

3. Place your Pocket-PC into the cradle and verify that the cradle is connected to your 
desktop PC. 

4. Insert the Diver-Pocket CD into your CD-ROM Drive.  The SWS installation CD 
Navigator should automatically launch.  If the CD Navigator does not launch 
automatically, open Windows Explorer, navigate the CD-ROM to the Diver-Pocket folder, 
and double click on either DiverPocket_Manager.exe or DiverPocket_Reader.exe.  

5. To begin installing your software, click on either the Install Manager button or the Install 
Reader button.  

6. Accept the default settings and select the following:  

• Microsoft .Net Compact Framework 2.0 

•  Microsoft SQL Mobile 2005 

•  SWS Reading Unit Driver  

•  SWS Diver-Pocket.  

7. Click Install to start the installation. 
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ActiveSync might display a dialog box with a list of programs that will be installed on your 
Pocket-PC. Programs that will be installed are marked with a grey checkbox. 

 

 
         This screen does not always appear. 

Note: On some Pocket-PCs you may be prompted to specify where to install the software: on 
the device or on removable storage.  Please ensure that the “Device” option is always selected.  
Diver-Pocket will not work properly if it is installed on removable storage.  

The Diver-Pocket installation will copy the required files to your Pocket-PC. Once the 
installation is complete, you will be prompted to verify whether additional steps are necessary 
(as show below).  
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If you are running Windows Mobile 2003 Second Edition, you might find the following 
message on the screen of your Pocket-PC:  
The program you have installed may not display properly because it was designed for a 
previous version of Windows Mobile. 
This message may be ignored.  Tap OK to continue. . 

8. A message will appear on your desktop PC confirming that the program has been 
successfully installed.  

9. Insert the USB Host/RS232 CF card to your Pocket-PC and connect the reading unit to the 
USB Host/RS232 CF card. 

10. Proceed to Getting Started with Diver-Pocket on page 12. 

2.2 Upgrade Diver-Pocket to 2009.1  
If you already have a previous version of Diver-Pocket (Pocket-Diver 
3.0/2.0/2.1.0.0/2.1.1.0/2.1.2.0) installed and you want to upgrade to 4.0.0.x during the 
installation, uncheck Microsoft .Net Compact Framework 2.0 and Microsoft SQL Mobile 2005 
options to speed up the installation. If you are upgrading from Pocket-Diver 2.x, after 
installing Diver-Pocket 4.0.0.x, Pocket-Diver 2.x may still exist on the PocketPC.  You can 
safely remove the previous version through the Remove Programs dialog in Windows 
Settings.  

2.3 Quick Installation Guide 
• Remove the USB Host/RS232 CF card from the Pocket-PC. 
• Install USB Host/RS232 CF card driver (latest drivers can be found on 

http://www.ratocsystems.com/). 
• Run DiverPocket_Reader.exe or DiverPocket_Manager.exe. 
• Plug in the USB Host/RS232 CF card. 
• Connect the reading unit. 
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3 Getting Started with Diver-Pocket 

This chapter will guide you through the basic steps to setup a project, acquire data from Divers 
and display data on your screen. The following chapters contain more details on specific topics 
and include Managing Projects, and Managing Diver Data. 

3.1 Launching Diver-Pocket 
After a successful installation, Diver-Pocket can be launched by tapping the Windows logo in 
the upper-left corner of the Pocket-PC screen. 

From the pop-up menu, tap Programs.  Finally, tap the Diver-Pocket icon.  

3.2 Diver-Pocket Tabs 
There are three different screens (tabs) in Diver-Pocket: Project, Diver and Data.  

• The main tabs will have an “Ok” button located in the top-right corner.  This button will 
close the application. 

• All sub-tabs will have an “OK” button located at the top-right corner.  This button will 
Close the sub-tab, but not the application.  

• If information needs to be saved, a “Save” button will be displayed. . 
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3.3 Creating a Project 
When starting Diver-Pocket for the first time, a 
message will inform you that the current database is 
empty and a new project needs to be created. Tap OK 
to proceed. 

Enter a Project Name and tap the OK button 

Confirm the default project settings by tapping the 
Save button. 

 

3.4 Reading Diver Data 
Tap the Diver tab at the bottom of the screen. A screen
containing empty fields will be displayed (as shown to
the left). 

Make sure a Diver is placed in the USB Reading Unit
and that the USB Reading Unit or DDC interface cable
is connected to your Pocket-PC.  

 

 

Tap the Data button to download the settings and data 
from the Diver. A progress bar indicates the status of 
the download process.  The fields (e.g. Location, 
Sample Method, Sample Rate) should now contain the 
Diver information.  
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3.5 Plotting Data 

 

Tap the Plot button to view the downloaded data as a 
time series plot. 

Within the plot screen, you can navigate the time-
series graph by using the zoom and pan tools. 

Tap the Settings button to display information about 
the plotted parameters or to change the display 
settings. 

  

If your Diver measures two parameters, assign the 
second parameter to the right axis. By doing so, the 
two parameters, each having a different range, will be 
shown on a different axis leading to a better resolution 
of both curves. 

Tap Apply to close the plot screen. 

 

You have now successfully downloaded data from a Diver and visualized the data in a time-
series plot. 
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3.6 Hiding & Exiting Diver-Pocket 

 

You can hide (minimize) Diver-Pocket by tapping 
the X in the upper-right corner. The program is not 
stopped and is still running in the background.  

To completely close Diver-Pocket, tap Application 
and then Exit. 
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4 The Basics 

There are three different screens or tabs in Diver-Pocket (as shown below).  

• The main tabs will have an “Ok” button located in the top-right corner. If selected, this 
button close  the application.  

• All sub-tabs will have an “OK” button located at the top-right corner.  If selected, this 
button will close the sub-tab, but not the application, without saving.  

• If information needs to be saved, a “Save” button will be displayed. 

The first tab is the Project tab.  At this screen you can define the project name, the project 
folder and the export settings. For more details on this topic, refer to Managing Projects (page 
12). 

The middle tab is the Diver tab. This screen is used for reading and programming Divers. For 
more details refer to (page 15). 

The third tab is the Data tab.  Here you can plot and export data. For more details, refer to 
Managing Diver Data (page 25). 

 

  
                   Project Tab                         Diver Tab           Data Tab 

4.1 Managing Projects 
In Diver-Pocket, a project combines data from multiple Divers, belonging to the same 
monitoring project. Each project can have its own default settings as defined by the user.  
As shown in the image below, each project requires a default project folder, an associated 
file name format and a file type for exporting data. When starting Diver-Pocket for the 
first time, you will be prompted to create a new project before proceeding. 
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4.1.1 Editing and Opening an Existing Project 
Tap the Project tab to display the project 
settings. The project settings include the 
following fields: 

The Project Name cannot be changed once the 
project has been created. Select an existing 
project from the Project Name drop-down box. 
If the current project has not been saved, you 
will be prompted to confirm the changes. 

Project Folder: This is the location where the 
exported (.dat, .mon and .csv) data files will be 
stored. With every Diver download, a binary .dat 
file will be created by default. The .mon or .csv 
files can be created automatically by setting the 
default export flag (see below) or manually from 
the Data tab. 

All created .dat, .mon and .csv files use the File Name Format settings. This allows you 
to associate a filename with three strings (serial number of Diver, location of Diver and 
timestamp of download). If the timestamp is not included as part of the filename (e.g. 
only serial number plus location name are included in name format), then a _1, _2 etc. 
extension will be added to each file in order to make the filename unique. NOTE: It is 
good practice to include the timestamp in the filename. 

File Type: This defines the type of files that are created when data is exported either 
manually or automatically. 

If the Export on Download checkbox is checked, a file is exported automatically with 
every Diver download. If the Pocket-PC’s memory is limited or if the additional export is 
too time consuming, you may export the same files manually from the database at a later 
point in time.  

Project Time Settings: 

For long term monitoring projects, the time of all the measurements must be aligned to a 
standard time to ensure that the sampling frequency is consistent when the time changes due to 
day light savings time.  Specifying the project time in Diver-Office ensures that your Diver is 
synchronized with the original Diver time and that no gaps or overlap occur in your data.  You 
can choose from the following options: 

Computer Time If you choose this option, the project time will always be 
the same as your computer time.  This is how project time 
worked in previous versions of Diver-Office 

Winter Time  
(Standard Time) 

If you choose this option, the project time will always be 
synchronized with standard time, e.g., UTC + x, where x 
depends on the time zones in your region; day light savings 
will be ignored.   

Summer Time 
(Daylight Savings Time) 

If you choose this option, the project time will always be 
synchronized with summer time, e.g., UTC + x – 1, where 
x depends on the time zone of your region; winter time will 
be ignored. 
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Most monitoring projects use standard time, completely ignoring day light savings time.  In 
some rare cases, long-term monitoring is done using day-light savings time (winter time is 
ignored).  Either time is acceptable, as long as it is maintained throughout the full duration of 
the monitoring project.   

For short term projects or pumping tests, you will most likely use the computer time, as shifts 
in time due to day light savings are usually irrelevant.  

Please note that in order for this feature to work, you must have the appropriate time zone 
selected in your PDA’s Date and Time Settings. 

Tap the Save button to save the settings of the current project. 

4.1.2 Creating a New Project 
Tap the Project tab. 

Tap the New button. The screen shown on the left 
will appear. 

Enter a project name. NOTE:  Do not use special 
characters (e.g\ /:*?”< > |) as the project name is 
the default name for the project folder.  

Tap the OK button. 

If necessary, modify the settings on the project 
screen as described in Editing and Opening an 
Existing Project (page 12).  

 

4.1.3 Deleting an Existing Project  

 

Tap the Project tab. 

Tap the Delete button to delete the current 
project and all related records in the database. 
The project folder will not be deleted 
automatically. Please use the Windows Mobile 
file explorer to delete the project folder from 
your Pocket-PC. 

 

4.2 Connecting to Diver-NETZ  
Diver-Pocket (v.3.0 and 4.0) allows you to read and program Divers from a remote location in the field, using a 
wireless connection.  To use this feature, a Diver-DXD dongle must be connected to your Pocket-PC and a 
Diver-DXT cable must be attached to each Diver. 
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Note: Currently, Diver-NETZ only supports one wireless connection within the effective range of the Diver-
DXT ( ~ 150 metres).  Multiple connections to Diver-NETZ can potentially disrupt communication, e.g., 
reading and downloading Dive data, with connected Diver-DXTs. 

4.2.1 Setting up a Wireless Connection 

 

From the Logger tab, tap the Wireless button to 
setup a wireless Diver connection.  

 

Note:  Diver-Pocket will become unstable if you 
unplug the Diver-DXD while operating in 
wireless mode.  Please be sure to exit Diver-
Pocket before you remove the Diver-DXD. 

 

 

 

In order to ensure that your Diver data remains 
secure and private, each Diver is assigned a 
password so that only you can retrieve its data.   

By default, each Diver is registered with the 
following password until you choose to change 
it: 

0123456789ABCDEF 

In the event that a Diver password is lost, you 
can select the Use Backup Password checkbox 
and retrieve the Diver using its built-in serial 
number (located on the Diver).  

Specify the Diver(s) password and tap Search to 
scan for available Divers.   
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Diver-Pocket will search for active Divers within 
a range of 150 meters. 

Note: The range will change depending on the 
environment in which the data collection is 
performed (e.g. environments with more 
topographical obstructions will decrease the 
potential range). The location of the Diver-DXT 
will also affect the range.  

It may take up to 30 seconds to locate a Diver. 
When a Diver is found, it is listed in the table 
under Location. The corresponding value listed 
in the Signal column represents the strength of 
the signal (0 –100).   

To connect to a Diver, select the checkbox beside 
the desired Diver from the table, and tap 
Connect.  

 

 

  

Now that you have connected to a Diver, you can 
proceed to read and program Diver settings, and 
download Diver data. 

The green status bars  in the top-right corner 
allows you to monitor the strength of your 
wireless connection while you work with 
wireless Divers.  The number of green bars 
increases as the signal strength increases, and 
vice versa.    

To disable a connection, tap the DXD Off button. 
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4.2.2 Downloading Data from Multiple Divers  

 

Diver-Pocket allows you to download data from 
multiple Divers simultaneously. To do so, first 
initiate wireless mode, as described in the 
previous section.   

Once the wireless Divers have been detected, 
select the checkboxes beside the desired Divers, 
and then tap the Read button.   

It is recommended that you use this feature only 
with connections that have a signal strength of 
atleast 40-50.  Connections below this threshold 
may freeze during the download process. The 
likelihood of this behavior is greater when the 
number of connected Divers increases. 

Note:  Diver-Pocket can download data from up 
to 6 Divers simultaneously..   

 

 

 

During the data download process, Diver-Pocket 
displays the progress for each Diver under the 
Progress(%) column.   

Each Diver is also colored depending on the status 
of the Diver.  Yellow indicates that the data 
download is in progress.   Green indicates that the 
Diver download has completed successfully. Red 
indicates that the download has been manually 
stopped.  

To manually stop downloading data from a diver, 
select the checkbox beside the desired Diver, and 
then tap the Stop button.  
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4.2.3 Changing Wireless Diver Password 

 

To change a Diver password, select a Diver from the 
location table and tap the Chg Pwd button. 

 

 

 

 

 

 

 

 

 

 

 

 

At the Change Radio Password screen, enter a 
new password for the wireless Diver.  You must 
confirm the new password by entering it again.  

Finally, tap the Change button to save the new 
password. If successful, a message will display 
confirming that the password has been changed.  
The Diver will then disconnect from the current 
network, and you will need to reconnect using 
the new password.  

Please refer to the Diver-DXT installation 
manual for more information on how to change 
the password. 
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5 Reading and Programming the Diver 

5.1 Reading Data and Settings from the Diver  

 
 

 

 

 

 

 

 

 

Tap the Logger tab to: 

• read Diver data, 

• program the Diver, 

• start and stop the Diver.  

Tap the Settings button to download the 
settings from the connected Diver. 

Tap the Data button to retrieve the data from 
the connected Diver. The download process 
includes: 

• Downloading the data to a binary .dat 
file. This is an image of the Diver 
memory and is stored in a sub folder 
(DAT) of the project folder. The 
download time is approximately five 
minutes for the entire Diver memory 
(48,000 readings). 

• Saving the data from the .DAT file to 
the database. This step takes less than 
ten seconds to complete. 

• If specified in the project settings, the 
data may be automatically exported to a 
*.MON or *.CSV text file. For a full 
Diver memory, this step takes 
approximately one to two minutes to 
complete.   
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5.2 Viewing QA/QC Log 

 

 

 

When data is downloaded from a Diver, Diver-Pocket 
performs a basic check for data that may be erroneous 
or corrupted.  If erroneous data is detected, Diver-
Pocket will list the time-series information and reason 
in the QA/QC log (shown to the side). 

Some reasons for corrupted Diver data may include: 

• The data includes maximum or minimum values, 
e.g, for a CTD-Diver, if conductivity values are equal 
to the minimum values of zero this may suggest that 
the Diver wasn’t properly submersed in water. If data 
is equal to the maximum this may suggest that the 
conductivity range is not suitable. 

• The data is corrupted due to a low battery in the 
Diver. 

 

 

5.3 Reading Actual Data from the Diver  

 

 

Tap the Actual button to display a real time 
measurement for each parameter of the 
connected Diver.  

NOTE: These values are only displayed and 
not saved to the database.   Also, real time 
measurements are only shown for the 
following Divers: Micro-Diver, CTD-Diver, 
Mini-Diver, CTD-Diver, and Cera Diver.  
Older Divers, such as the CTD stainless steel 
Diver, will only display the most recent stored 
measurements on all channels.  

Tap Verify to enter a measurement manually 
and compare it to a measurement taken with 
the Diver (shown below). 
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5.4 Programming the Diver 
Diver-Pocket allows the programming of the 
following settings: Location, Sample 
Method, Sample Rate, and Altitude.  

 

To change any of these settings, manually 
enter the desired values.  Once the new values 
have been entered, tap Program. 

 

To confirm that the new settings have been 
programmed, tap Settings.  The fields should 
appear blank for a moment before displaying 
the newly defined settings.  

 

 

 

5.4.1 Location 
The Diver location is an identifier that may be specified by the user on the Logger tab. This is 
usually required if a Diver is assigned to a new location. NOTE: It is highly recommended that 
you assign a unique name to each Diver location. Also, since the Location name will be used 
as part of the filename for exporting data, the Location name does not accept special characters 
that would lead to an invalid filename (e.g. \ / : * ? * < > | ) 

5.4.2 Sample Method and Sample Rate 
The Sample Method may be one of the following: 

• Fixed 

• Event-based 
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• One of the predefined pumping test settings (Setup A, B, or C), 

• Averaging  (Micro-Diver & Cer-Diver only) 

• or User Defined. 

Fixed  
A fixed sample method will acquire and store data at regular time intervals.  Select a unit from 
the Record Rate drop-down box (e.g. Hour, Minute, Second, 0.5 Second) and enter an 
associated time value in the adjacent box.   

Example 

With a 10-second record rate, the CTD-Diver takes a measurement every 10 seconds on all 
channels settings and stores this value in its internal memory. The maximum number of 
measurements is 16,000. In this case, the internal memory will be full after 1 day, 20 hours, 26 
minutes and 30 seconds. The Diver stops taking measurements when the memory is full. 

NOTE: A CTD-measurement will be stored as a record with the data: date + time + level + 
temperature + conductivity. All measurements are imported together as one series in Diver-
Pocket. 

Event Based 
When you select this method, the Diver compares each sample to the last stored sample and 
calculates a difference. A new sample is only stored when the difference exceeds a specified 
percentage from the last stored sample on the leading parameter. Generally, the leading 
parameter is pressure. For the CTD-Diver the leading parameters is conductivity.  

If you select this method, the Variation field will be displayed. In the field Variation, specify 
the appropriate difference threshold. Enter this difference as a percentage of the total range of 
the Diver. The percentage must lie between 0.1% and 25%. Also, you must specify a Sample 
Rate 

Example 

Suppose you entered a variation of 2.5 % for a CTD-Diver with an 80 mS/cm measuring range 
and a sample rate of 30 minutes. The CTD-Diver will then take a measurement every thirty 
minutes and compare it with the last stored conductivity value. It will only store a new 
measurement: 

• if the conductivity differs by 2 mS/cm (i.e. 2.5 % of 80 mS/cm) or more from the 
last stored conductivity value, or 

• if the conductivity did not differ by at least 2 mS/cm in the last 250 measurements. 

Conductivity is the leading parameter for the CTD-Diver. Therefore, changes in water depth 
will not affect the storage of measurements. 

NOTE: Energy is expended when a sample is acquired, even when the sample is not stored in 
memory. Therefore, this method may deplete battery resources before the Diver memory can 
be completely filled. .  

You can minimize this problem by specifying a modest sample rate.  
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Averaging Sampling Method 
When programmed with the Averaging Sample method, the Diver samples data at a specified 
“fast” rate (Sample Interval) and then stores an average of these values at the specified 
averaging rate (Record Interval).   

For example: 

Record Interval: 1 hour  

Sample Interval: 1 Minute 

When programmed and started with these settings, the Diver will read a sample every minute, 
and record an average of the samples every 1 hour.  

Predefined Pumping Tests  
Diver-Pocket includes three convenient predefined pumping tests available from the Sample 
Method drop-down box.  This method is only available for Divers that support this feature. 

The specifications of these predefined sample methods are as follows: 

Pumping Test Setup A  
Base Sample Rate: 0.5 seconds 

Step Number of 
samples #Intervals 

1 1200 1 

2 5400 2 

3 41400 10 

 

Pumping Test Setup B  
Base Sample Rate: 1 second 

Step Number of 
samples #Intervals 

1 600 1 

2 1080 5 

3 5400 10 

4 40920 30 
 

Pumping Test Setup C  
Base Sample Rate: 5 seconds 
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Step Number of 
samples #Intervals 

1 120 1 

2 270 4 

3 900 12 

4 1800 60 

5 44910 240 
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User Defined Pumping Test (Cera-Diver and Micro-Diver only) 
You may also define your own pumping test sample method by tapping the Pumptst button 
and specifying the necessary details: 

Tap the Pumptst button to display the User 
Defined Sample Method screen. 

Tap the Add button and a new dialog box will 
appear. Specify a name, description (optional), 
and a base sample rate. Once these fields are 
completed, tap the Next button to continue. 

 

In the Define Step dialog , you must enter the 
number of samples and the number of intervals 
for your sample method (as shown to the left). 

Tap the Save button to save the method. A pop 
up message will appear confirming the method 
has been saved. 

Tap Ok to return to the previous dialog and 
then Ok again to return to the main Pump Test 
dialog. 

NOTE: In order to save the sample method, 
the total number of samples must equal the 
total memory of the connected Diver. 
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5.4.3 Altitude 
Specify the altitude above sea level for the 
location of the Diver. The value entered will be 
in the units that are programmed in the Diver. 
(i.e. meters or feet). The ranges are: 

• -300 m to 3,000 m 

• -1,000 ft to 10,000 ft 

Note: Altitude is only available for CTD-
Divers including DI240-DI245, DI209-DI220.  

5.5 Stopping a Diver 
In order to stop a Diver, the settings must have been read and the status must be “started”. 

Tap the Stop button. A confirmation screen will be displayed to prevent accidental stopping of 
the Diver. Tap Yes to stop the Diver or tap No to prevent the Diver from being stopped. 

5.6 Starting a Diver 
Before you start a Diver, make sure that you have programmed the Diver using the Program 
button. After tapping Program, the fields will momentarily appear blank before displaying the 
settings. Verify that the settings are correct. 

To start a Diver, tap the Start button to display 
the Start Logger dialog box. 

Select Immediate Start to start the Diver 
immediately, or select Future Start to specify a 
future start-time.  

Smart Future Start automatically restarts the 
Diver at the next required sample time based on 
the original start-time and the sample interval. 
You may also choose to synchronize the Diver’s 
internal clock with the project time by checking 
the Sync Clock with Project Time checkbox 
box. .   

ATTENTION: 

All data in the Diver memory will be erased and 
irretrievable once the Diver is started.  Be sure 
to download this data before proceeding.  
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5.6.1 Smart Future Start 
The Smart Future Start option provides optimal use of Diver memory, download speeds and 
data management. The Smart Future Start option can be explained best by the picture depicted 
below. Suppose the Diver was started at t0 and data was collected. At t1, the Diver is stopped 
and data 1is read. The Smart Future Start time is given and the Diver proceeds to sample as if 
it was not stopped. At t2, data 2 is collected, the Diver is stopped and the Smart Future Start 
time is given. Data 2 can then be linked to data 1 in the Logger Data Manager. To ensure that 
timed data is accurate, the Smart Future Start can be synchronized with the Pocket-PC clock by 
checking the Sync Clock box.  

 

time

le
ve

l

t1
read data
stop Diver

future start

t2
read data
stop Diver

future start
data 1

data 2

t0
start

 
 

5.7 Managing Diver Data 
Tap the Data tab. You will see a list of all downloaded 
time series of the current project. 

Every Diver download is saved to the database as a time 
series. A time series is defined by the location, a 
timestamp of the download time, and a unique Diver 
serial number. You may select one or several time series. 

Tap the Export button to export all selected time series to 
text files, e.g., *.MON, *.CSV.  This will create one file 
for each selected record in the project folder. Remember, 
the file format, name, and target path (Project Folder) are 
defined in the project settings on the Project tab. 

Tap the Delete button to delete the selected records from 
this project.  

NOTE: After you delete a record, apply the Compact 
Database command from the Application menu.  This 
will shrink the database file and save space on the Pocket-
PC.  

Tap the Plot button to display the selected record in a 
time series. Note that this command is only available 
when only one record is selected. 
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5.8 Exporting Data to a PC 
To transfer data from the Pocket-PC to your Desktop PC, connect the Pocket-PC to the PC and 
start Microsoft ActiveSync (if not automatically started). Click the Explore button to browse 
the contents of the Pocket-PC (as shown below).  You can transfer files to your PC by using 
Copy/Paste or Drag/Drop.  

 

 

5.9 Time Series Plots 

 
 

There are two ways to display downloaded data in a time 
series plot: 

• Tap the Logger tab and tap Data to download 
data from the Diver. As the download is 
finished, the plot button will become active. 
Tap the Plot button. This will display the 
downloaded data. 

• Tap the Data tab. Select a record from the 
stored list. Tap the Plot button to display the 
downloaded data. 

To enhance the plotting speed, Diver-Pocket will resample 
the data whenever a time series plot is made. NOTE: Only 
values that are different by 0.1% will be displayed. 

The data for all the available parameters will be displayed. 
To hide a parameter, tap on its name in the legend. Tap it 
again to unhide it. 

You may use the following navigation buttons to view a 
selection of the plot in more detail: 

Move left 

More right 

Zoom in 

Reset default settings 

Zoom out 
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Move up 

Move down 

5.10 Plot Settings 
Tap the Settings button to display the parameter 
settings (as shown to the side). 

The grid in the upper part of the screen displays 
the parameters that are available in the plotted 
time series. The minimum and maximum values 
are read from the Diver settings and cannot be 
changed. However, you may assign parameters to 
individual axis to improve the vertical resolution 
of the plotted parameters. The last column of this 
grid allows you to define how the data is 
represented on the plot (e.g. lines or bars). 

Check the Legend Visible box to make the plot 
legend visible.   

The 3 Dimensions option allows you to give 
your plot a 3D or 2D appearance. 
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6 CTD-Diver Calibration 

Diver-Pocket features the ability to calibrate the ceramic CTD-Divers as well as retrieve the 
calibration history from the CTD-Diver. It is necessary to regularly calibrate the CTD-Divers 
to ensure accuracy and reliability. 

6.1 Calibration 
The ceramic CTD-Diver can be calibrated at a 
maximum of four points. The solution must have a 
temperature between 5 °C (41 °F) and 30 °C (86 °F). 
NOTE: It is advisable to place the fluid(s) in the room 
where the calibration is to take place before the actual 
calibration starts to allow the fluid temperature to 
stabilize.  Once the fluid temperate has stabilized, you 
can proceed to calibrate the Diver.  

Connect the CTD-Diver to the Pocket-PC and immerse 
the CTD-Diver in the solution. 

Tap the Logger tab and then tap the Settings button to 
read the settings from the Diver. 

Once the Diver is recognized as a CTD-Diver, the 
Calibrate button will become active.  

Next, tap the Calibrate button to open the Calibration 
wizard.  

Select the check box(es) next to the appropriate solution(s) that will be used to calibrate the Diver. 

Tap the Calibrate button to begin calibrating the CTD-Diver.  

A message will appear stating that all data on the CTD-Diver will be erased, tap Yes to 
continue or No to cancel.  

A message will appear to immerse the CTD-Diver in the selected solution. Tap Ok to 
continue. 

Diver-Pocket will then calibrate the CTD-Diver according to the specified solutions. If the 
calibration was successful, a message will appear. Tap Ok to continue. 
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6.2 Calibration History 
Diver-Pocket is also capable of reading and 
displaying the calibration history from CTD-
Divers. Each time a CTD-Diver is calibrated, the 
settings are saved to the CTD-Diver’s internal 
memory. This feature is useful for monitoring 
changes in calibration over time which may aid 
in explaining significant variations or anomalies 
in data. 

Ensure the CTD-Diver is connected to Pocket-
PC. 
Tap the Logger tab, and then tap the Settings button 
to read the settings from the Diver. 

Once the Diver is recognized as a CTD-Diver, the 
Calibrate button will be made available.  

Tap the Calibrate button to open the Calibration 
wizard. 

Tap the Calibration History tab at the bottom of the 
screen (as shown to the left). 

The Calibration history will be displayed as a plot. . 
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7 Application Settings 

You can modify the default application settings in Diver-Pocket by accessing the Application 
button (as shown below).    

7.1 Changing the Units 
Tap on Units to change the default units.  

 

7.2 Changing the Units (Detail) 
From the drop-down menus, specify a unit for 
each parameter (Length, Diver Pressure, 
Temperature, Barometric Pressure).  

 

Tap “Save” to save the changes. The settings 
will apply to the entire Application and export 
files.  

 
NOTE: The “Barometric Pressure” units are only 
used in “Actual” form, please refer to the “Reading 
Actual Data from the Logger” 
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7.3 Changing the Language 
This option allows you to change the language of 
Diver-Pocket.  Select from English, Spanish and 
Dutch.  

 
 

7.4 Compressing the Database 
Please recall that deleting any data in the 
database does not shrink the size of the 
database. Tap Application in the menu bar and 
then tap Compact DB to compact the database 
(as shown to the side). 
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8 Troubleshooting  

8.1 Interruption in Communication  
Diver-Pocket will inform you with a message if the communication between the computer and 
the Diver is disturbed, e.g., when there is no Diver connected. 

You can confirm the message, take action to solve the problem and then try again. 
Communication may be disturbed for the following reasons: 

• The USB Reading Unit is not properly connected to the Pocket-PC.  
Action: Ensure the USB Reading Unit or RS232 Reading Unit is connected to the 
Pocket-PC.  

• Diver-Pocket tried to communicate with the Diver just as it was taking a measurement.  
Action: Confirm the message and try again. 

• The Diver is not properly connected to the USB Reading Unit or RS232 Reading Unit.  
Action: Ensure that the optical connectors on both the Diver and the USB Reading 
Unit are clean. If not, you can clean them with a soft cloth. 

• The Pocket-PC shows a message that an unknown device was found. 
Action: see bullet points below. 

If the actions outlined above do not resolve the communication problem, proceed as 
follows: 

• Exit the Diver-Pocket program using menu Application  Exit 

• Unplug the USB Host CF card 

• Disconnect the USB Host CF card from the USB Reading Unit 

• Plug in the USB Host CF card 

• Connect the USB Reading Unit to the Pocket-PC  

• Wait 5 seconds 

• Start the Diver-Pocket program and tap the Read button 

If these actions do also not solve the issue, try a Soft Reset of the Pocket-PC as described in 
the product Pocket-PC manual. 

8.2 Pocket-PC Power Management Issues 
Default settings on most Pocket-PCs automatically shut off if there is no user activity for a set 
length of time, typically 3 to 5 minutes. This can cause the Pocket-PC to shut off and disrupt 
the download process. To avoid this problem, the Power Settings must be changed on the 
Pocket-PC. In Windows Mobile, these settings can be accessed in the following manner: 

Tap Start menu > Settings > System tab at bottom of Settings window > Power icon > Advanced tab  

At this screen, there will be a check box which can turn the power save feature on or off. It is 
recommended that this feature is disabled when working with large datasets to avoid download 
disruption. 
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